
prEdit
prEdit allows you to create a paper edit from speech transcriptions, and export it as an edited 
sequence to Premiere Pro or Final Cut Pro.
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Workflow
prEdit works with transcripts that allow editing of video using text as the primary interface. 
After preparing transcripts the media and transcription information is imported to prEdit.
In prEdit interviews can easily be broken into paragraphs, which are effectively subclips, and 
metadata or log notes added. These subclips can be searched and built into a story before 
being exported to Final Cut Pro, Premiere Pro or a range of other export formats.

Prepare Transcripts
prEdit will work with almost all current transcription formats that include time stamps or 
timecode. You can move a project into prEdit without any loss of entered log notes: these will 
be preserved, displayed in prEdit, and returned to the NLE using your existing transcripts.
Alternatively, if you’re creating new transcripts, we recommend 3PlayMedia.com and their 
JSON format as the transcription format that has the most accuracy within prEdit, with the 
minimum effort.
prEdit also supports transcripts coming from the Adobe speech analysis feature: either using 
the automatic transcription, with a script fed to Premiere Pro or Soundbooth, or using a 
transcript through an Adobe Story > OnLocation > Premiere Pro CS5 workflow, that preserves 
names and punctuation.

http://3PlayMedia.com
http://3PlayMedia.com


Edit transcripts to selects and add log notes
In the Transcript View, you move between clips, choose a paper color for the clip. In this view 
you can add log notes, additional to what has been entered in the NLE. The interface design 
makes prEdit the fastest place to enter log notes because it fully supports auto-complete. 
Individual clips can be played at any time.

Edit selects into a Story
In the Story View, you can search through the selects using any of the log note criteria, or by 
searching through the text. Stories are built from these selects by moving a select from the 
Selects List to the Story. Selects can be further edited within the story view to trim the select, 
moving unwanted material back to the Selects List. Selects can be moved around freely within 
the Story Narration can be added to a sStory and temp audio will be created.

Export
From prEdit, the results can be sent directly Final Cut Pro, exported as XML for Final Cut Pro 
or Premiere Pro. The text can be output to a text file or a voice-over script ready for 
recording containing all the narrative material from the Story.

Working with Text Transcriptions
prEdit supports a number of transcription formats and workflows and it looks for the 
“sidecar” file (.txt, .rtf, .doc or .docx) in the same folder as the media file. prEdit will work 
with most “industry standard” timecode-stamped transcriptions. This includes files with 
timecode or time stamps at the start of every paragraph or where the time stamps are mid-
paragraph. The more time stamps in the transcript, the more accurately the video will match 
the text. You can use the Preview window to trim video to match the transcript (see Using 
Preview Windows).
prEdit can recognize time stamps in various formats separated by “:” or “;” or “.” and 
optionally surrounded by square brackets []. For example: 01:23:45 or 01:23:45:21 or 
1:23:45 or 1.23.45 or 1:23:45.420
If you have transcripts, they simply need to be named to 
match the media file name. These files are placed in the 
same folder as the media file and will be automatically 
recognized by prEdit. You may choose to remove any 
header or footer material irrelevant to the transcript so 
that this text is not added to your transcript in prEdit.

Advantages: Minimal variation from current 
workflows. Uses transcripts you already have; work 
with the same vendors you currently do; pick up a 
project and move it from FCP to prEdit without losing any work: all log notes already 
made in FCP will be visible and editable in prEdit.
Disadvantage: The time stamps are not “per word” so there will be some variability 
when creating new subclips. This can be corrected within the prEdit viewer.



Working with JSON Transcriptions
3PlayMedia.com and MediaSilo.com can provide transcripts in multiple formats, including 
human-readable formats, but specifically a JSON (JavaScript data format) version that has 
time-stamps for every word. Like text transcriptions prEdit looks for the “sidecar” JSON file in 
the same folder as the media file.
Both 3PlayMedia.com and MediaSilo.com offer a range of services beyond transcriptions.
These transcription files simply need to be named to match the media file name (except 
with .json at the end, not .mov or other suffix). These files are placed in the same folder as 
the media file and will be automatically recognized. 

Advantages: Higher accuracy when making subclips. Most accurate, with least work, 
workflow.
Disadvantages: A new vendor relationship may need to be created.

Creating Adobe Speech Transcriptions
With the available Adobe Production Suite tools there are three ways that the time stamps can 
be generated and embedded in the file ready for prEdit:

1. Use Speech Analysis in Premiere Pro or Soundbooth CS5;
2. Use a human-derived transcription to drive the speech analysis in Premiere Pro or 

Soundbooth CS5; or
3. Use a human-derived transcription and format the text in Adobe Story as a single 

scene film script; embed the script into the media file with Adobe OnLocation and 
analyze the speech in Premiere Pro.


 Note: Premiere Pro CS5 is required to export Final Cut Pro XML for prEdit.
We have tested these three workflows and would make the following comments before going 
into details of each.

• Speech Analysis in CS5 is highly variable in result. In our testing results varied from 
very good (close to 95% accurate) down to 15-20% accurate on some speakers. Both 
Premiere Pro and Soundbooth provide the ability to correct text to match the speech 
inside the application’s Speech Analysis (Metadata) window. This is definitely viable 
when you have a “good” speaker relatively accurately analyzed.

• Where the results from Speech Analysis are unlikely to be accurate (or have proven 
not to be) it is part of the Adobe workflow to provide it with a human-derived 
transcription as a “guide”. This is supposed to provide a word-accurate transcription 
locked to the transcript but in our testing it was close, but not precisely accurate.

• In neither 1 nor 2 workflows did we ever experience Speech Analysis accurately 
determining speaker identity. When multiple speaker analysis is turned on, there 
were usually many more speakers identified than were in the interview.

• Workflow 3, while a little more effort, pays off when imported to prEdit because the 
full grammar is retained, and speakers are accurately identified, which allows prEdit 
to automatically split each speaker into subclips at each speaker change.

Note: Further instruction on using Soundbooth and Premiere Pro for speech transcription can 
be found at http://help.adobe.com/en_US/Soundbooth/2.0/WS29F692D2-7A49-44db-
A109-AE016B766767.html 

http://help.adobe.com/en_US/Soundbooth/2.0/WS29F692D2-7A49-44db-A109-AE016B766767.html
http://help.adobe.com/en_US/Soundbooth/2.0/WS29F692D2-7A49-44db-A109-AE016B766767.html
http://help.adobe.com/en_US/Soundbooth/2.0/WS29F692D2-7A49-44db-A109-AE016B766767.html
http://help.adobe.com/en_US/Soundbooth/2.0/WS29F692D2-7A49-44db-A109-AE016B766767.html


1. In Adobe Soundbooth CS4/CS5 or Premiere Pro CS5, open the media files (video
+audio or audio-only) you want to transcribe, then in the Metadata panel (Window 
> Metadata) click the Transcribe button. More accurate speech analysis can be 
achieved by adding a script that matches the recorded dialog in Premiere Pro or 
Story. 

2. Correct the transcript in Soundbooth by double-clicking on a word to edit it; 
Control-click on a word and from the contextual menu choose Insert Word Before, 
Insert Word After, Delete Word, Merge With Next Word or Merge With Previous 
Word; optionally add punctuation and capitalization. (See http://www.adobe.com/
devnet/video/articles/metadata_video_03.html for more details.) 

Tip: Soundbooth CS5 and Premiere Pro CS5 support multiple workflows for increasing the 
accuracy of a transcription by feeding it an existing transcription obtained via more 
convention means. 

• Soundbooth can import a text transcript or file from Adobe Story that will improve accuracy 
but not preserve punctuation. In Soundbooth each media file is processed individually.

• Premiere Pro CS5 can batch process media files for transcription using Adobe Media 
Encoder. 

• If the transcription is imported first to Adobe Story, then empty Clips created in Adobe On 
Location, and merged in Premiere Pro CS5 and sent to AME for encoding, then punctuation 
and capitalization are maintained.

Making Corrections to a Transcript
Corrections to a transcript can be made either in Premiere Pro/Soundbooth or in prEdit.

• Corrections that add, remove, combine or split a word should be done in Soundbooth. The 
goal for corrections is to associate words in the transcript with areas of the waveform. When 
you click the Play button in the Metadata window, the appropriate word should highlight as 
the audio plays.

• Corrections of punctuation or capitalization can be made either in Soundbooth or in prEdit:
1. In prEdit’s Transcript list or Story list, select a word or words.
2. Control-click to open the contextual menu. This gives you access to Look Up in 

Dictionary, Spelling and Grammar Tools, Substitutions and Transformations.
Tip: Since prEdit has the easiest correction workflow, our recommendation is:

• Do all corrections that require splitting or adding words in Soundbooth; then

• Do all other corrections in prEdit. prEdit will reject edits that change the word count 
in a transcript. However you can add a word and maintain the word count by using 
the underscore character between words like_this.

http://www.adobe.com/devnet/video/articles/metadata_video_03.html
http://www.adobe.com/devnet/video/articles/metadata_video_03.html
http://www.adobe.com/devnet/video/articles/metadata_video_03.html
http://www.adobe.com/devnet/video/articles/metadata_video_03.html


Starting a new prEdit project in Final Cut Pro
1. In Finder arrange your media files and their corresponding “sidecar” text or JSON 

files. (You can mix-and-match transcript formats: prEdit will first look for Adobe 
speech transcription in the media file, then for a JSON sidecar file, then for a text 
sidecar file.)

2. In Final Cut Pro, import the media files.
3. (Optional) Create multiclips from each camera angle.
4. (Optional) Create a new empty sequence with your desired sequence settings.

Tip: Drag a clip with the most common format into the empty sequence. If the 
sequence settings need to change, Final Cut Pro will offer to change the sequence 
to match. Then delete the clip to leave an empty sequence.

5. Select the clips and sequence in the Browser window (or an enclosing Bin) then 
choose the File menu, and from the Export submenu select XML… 

6. Name and save the clips XML file.
7. In prEdit, click the Import Clips XML... button and select the exported XML file.

Important: The clips must be online when importing XML into prEdit.
8. Choose the File menu and select Save. Name and save the prEdit project.

Starting a new prEdit project in Premiere Pro
1. If you’re using sidecar transcripts, in Finder arrange your media files and their 

corresponding “sidecar” text or JSON files. (You can mix-and-match transcript 
formats: prEdit will first look for Adobe speech transcription in the media file, then 
for a JSON sidecar file, then for a text sidecar file.)

2. In Premiere Pro CS5, select the transcribed clips (or Bin of clips) in the Browser 
window; then choose the File menu, and from the Export submenu select Final Cut 
Pro XML… 

3. Name and save the clips XML file.
4. In prEdit, click the Import Clips XML… button and select the exported XML file.

Important: The clips must be online when importing XML into prEdit.
5. Choose the File menu and select Save. Name and save the prEdit project.

Using the Transcript View
The Transcript View is where you create subclips (also called selects) from the transcript of 
each media file, and add logging information and comments to the subclips.

1. You can add logging information and comments for the entire clip. If any logging 
information or comments were added to the clip before exporting XML, they will 
appear in the appropriate fields. Final Cut Pro’s Label 2 field is used for Priority, 
and its master comments fields are used for Story Keywords, Location, the Person 
speaking, and the Event or Theme. Logging information appears in both Premiere 
Pro and Final Cut Pro, but the Comments fields are only visible in Final Cut Pro (see 
About Master Comments).



2. You can change the paper color for the selected transcript from the color popup 
menu.
Tip: Set a different paper color for each interview subject.

3. To break the clip into subclips, double-click on the transcript text to enter editing 
mode, then place the cursor between some words and press the Return key: the 
clip splits into two subclips. Spelling corrections, capitalization and punctuation can 
also be added in editing mode (see Making Corrections to a Transcript). 
Tip: When splitting a clip, the subclips get the same logging information, comments 
and paper color as the parent clip. To save time, enter common information (such 
as person, location and event) for the original clip before splitting it into subclips.

4. Adjacent subclips can be rejoined by selecting both subclips and clicking the Join 
button.

5. Initially, each subclip is marked as Good. To remove interviewer questions, false 
starts and bad takes, select one or more subclip transcripts and turn the Good 
checkbox off (or type ⌘G). The transcript’s text changes to grayed out, so you 
always see the full transcript for a clip.

6. Subclips can have different subclip names, logging information, comments and 
paper colors.  If you select multiple subclips, logging information and comments 
can be added to all the  selected subclips (provided the field doesn't already have 
an entry for any of the selected subclips). To make entry of Logging Information 
and Comments faster and more consistent, either: 

• click the popup menu beside the field to choose from a list of previous entries; 
or

• start typing in the field and it will autocomplete with the closest match.
7. Story Keywords and Person can have multiple comma-separated entries, so these 

are handled in a different way to the other Comments fields:
• start typing in the field and the possible matches appear in a list underneath;

• type a comma after the text to turn it into a “token”;

• type ? to see a popup menu of all Story Keywords or People. 
8. To preview the video of a subclip, select it in the Transcript list and click the 

Preview button, or press the Space bar. The subclip video plays in a Preview 
window (see Using Preview Windows).

9. If the subclip’s video doesn’t match its transcript, you can use the Trim sliders in 
the Preview window to adjust the in and out point by up to 2 seconds (see Using 
Preview Windows).

10.Use the search field to filter the subclips to show only those with the search 
word(s). Using the popup menu you can limit the search to Transcript, Story 
Keywords, Location, Person, Event or Theme, or Everywhere (see About Master 
Comments). The search is not case-sensitive. Recent search word(s) can be 
accessed from the search field popup menu.

11.To change to another media file, select it in the Clips list.
12.When two or more prEdit project are open, you can copy clips from one project to 

another by clicking the Copy Clips… button. From the popup menu of open prEdit 
projects, choose the project to send the clips to.



About Master Comments
• Story Keywords (Master Comment 1): This is where you enter keywords, or tags, for this 

subclip. You can enter multiple keywords separating with a comma. When multiple 
words are entered, each item between commas is identified as a keyword and turned 
into a token.

• Location (Master Comment 2): An identifier for where this clip was shot. 

• Person – who’s on camera (Master Comment 3): Enter the name of the subclip's speaker 
on camera. If the shot starts on one speaker and ends on another, enter both names 
with a comma in between. Each name is turned into a token.

• Event or Theme (Master Comment 4): Provides an overall context for this clip – where 
does it fit within the overall story arc, or what is being referred to in this clip? The Event 
or Theme tag is used to provide context for the clip when being edited and is often 
related to the question asked by the interviewer.

Using the Story View
Once the transcripts have been broken down into subclips, change to the Story View. Here 
you build the Story from your Selects.

1. Click the Story View toolbar button to change to Story View. The Selects list on the 
left initially contains all the subclips from the Transcript lists that were marked as 
Good.

2. To find the selects you want, use the search field above the Selects list to filter the 
subclips to show only those with the search word(s). Using the popup menu you can 
limit the search to Transcript, Story Keywords, Location, Person, Event or 
Theme, or Everywhere (see About Master Comments). The search is not case-
sensitive. Recent search word(s) can be accessed from the search field popup menu.

3. To preview the video of a subclip, select it in the Selects list and click the Preview 
Select button, or press the Space bar. The subclip video plays in a Preview window. 
You can have multiple Preview windows open at the same time.

4. Selects are moved from the Selects list to the Story list on the right by selecting 
them in the list and clicking the Add button; or you can simply drag them over to 
the Story list. The story duration updates at the top of the Story list.

5. Subclips in the Story list can be rearranged by dragging and dropping them.
6. To remove a subclip from the Story list, select it and click the Remove button; or 

drag it back to the Selects list. The story duration updates at the top of the Story 
list.

7. As you build your story, you may find that your initial subclips are too long. Like 
the Transcript list, subclips in the Story list can be trimmed by typing a Return in 
the transcript text when in editing mode. The unwanted parts of the transcript can 
be removed from the Story list by sending them back to the Selects list. They can 
also be removed from the Selects list by turning their Good checkbox off (or type 
⌘G).
Tip: Because you can split and join subclips in the Story list, use the Transcript list 
to do the initial division into subclips and then refine further in the Story list.



8. Adjacent subclips from the same clip can be rejoined by selecting those adjacent 
clips and clicking the Join button.

9. To add a voice over script to the story, select a subclip in the Story list and click the 
Add V.O. button. An empty Voice Over clip is added below the selected subclip. 
Type in your voiceover text and a placeholder voice over file will be created (see 
About Voice Overs).

10.To preview part of the story as video, select one or more subclips in the Story list 
and click the Preview Selected button, or press the Space bar. The Preview window 
will play the selected subclips in the order they appear in the Story list (see Using 
Preview Windows).

11.To preview the paper edit as video, deselect any selected subclips by clicking the 
Deselect All button (or Esc key), then click the Preview Story button (or Space 
bar). The Preview window will play the Story list subclips in order (see Using Preview 
Windows).

12.Once the Story has been built, you can export the paper edit by clicking the Export 
button. Choose your Frame Rate from the popup menu and choose between Save 
Excel Spreadsheet, Send to Final Cut Pro, Save XML for Premiere Pro, Save 
zipped XML file (for emailing to an editor), Save Text Transcript, or Save Voice 
Over Script (the temporary audio that needs to be replaced).

• If saving a spreadsheet, name and save the Excel file. The spreadsheet has 
columns for Subclip Name, Source In, Source Out, Duration, Person, 
Transcript, and File Path. The .xls spreadsheet created by prEdit can be 
opened by Excel, Numbers, Open Office or Google Docs.

• If sent to Final Cut Pro, choose the 
original project in the Import XML 
dialog’s Destination popup menu, 
and either: use your current 
sequence preset by leaving the 
Sequence Settings popup menu set 
to (auto); or select the appropriate 
sequence preset from the Sequence 
Settings popup menu and click the 
Override with settings from XML 
checkbox “off”. 
Each “Good” select is added to the 
project as a subclip in a bin named 
for the master clip with the logging 
information and comments entered 
for it. The new sequence contains the 
subclips in Story list order with 
sequence markers containing the 
person speaking and speech 
transcript marking the duration of the 
spoken transcript.

IMPORTANT NOTE: Final Cut Pro by default will import the sequence to your 
current Sequence Preset setting (Final Cut Pro > Audio/Video Settings...) 
unless you choose a different setting in the Import XML window. If you find 
that the sequence requires rendering, open the Sequence Settings window 



(Sequence > Settings... or Command-0) and change the Compressor to 
match your media, or select a new preset by clicking the Load Sequence 
Preset… button. You can change any settings except for Editing Timebase.

• If saving for Premiere Pro, name and save the XML file. In Premiere Pro choose 
the File menu and select Import. Each “Good” select is added to the project as 
a subclip (in a bin named for the master clip) with the logging information 
entered for it. The new sequence contains the subclips in Story list order, and 
the transcript is available in the Metadata window.

• If saving a zipped file, name and save the .zip file.

• If saving a text transcript or Voice Over script, name and save the text file. 
Each subclip’s transcript appears as a separate paragraph with the Person 
name and start timecode above.

About Voice Overs
• A Voice Over is a clip where you don’t have media recorded yet, so prEdit creates a 

placeholder in the Story list and an AIFF file from the script using Mac OS X’s Text to 
Speech. The AIFF file is recreated any time the script is edited, and is saved with your 
other media files.

• Voice Over clips can have logging info and comments entered in the Transcript view just 
like any other subclip.

• To change the Text to Speech settings, open System Preference’s Speech panel and click 
the Text to Speech tab. You can choose a voice and adjust the speaking rate. “Alex” and 
“Vicki” are the highest quality voices.

• To recreate all your voice overs with new Text to Speech settings, click the Remake V.O. 
button (you may need to click Deselect All to change the button from Add V.O. to 
Remake V.O.).

Using Preview Windows
Preview Windows are separate windows that play a subclip, selected subclips or the Story.

• Previews and thumbnails are only available if the original media files are online.
Tip: You can continue to use prEdit for logging, breaking down clips into subclips and 
building the paper edit even if the media files are offline.

• You can have multiple Preview windows open at the same time.

• Use the Space bar to play and pause video in the frontmost Preview window.

• The Preview windows can be resized.

• The title of the Preview window playing a subclip will be 
the subclip name if set, or the clip name; the title of the 
Preview window playing the story will be “Story”.
Tip: Use the Window menu to switch between Preview 
windows and prEdit project windows; or use ⌘` to cycle 
between the windows.

• You can adjust a single subclip’s in or out points by 
using the Trim In and Trim Out sliders so that the video 
matches the transcript.



Preferences
Choose the prEdit menu and select Preferences to open the Preferences window.

Autosaving
Use the popup menu to choose an interval for automatically saving changes to your prEdit 
project. Larger projects can take several seconds to save, and the application may become 
momentarily unresponsive (spinning beach ball) during an autosave.

Software Updates
Use the Check at Launch checkbox to choose whether to automatically check for software 
updates. You can manually check for software updates by clicking the Check now button, or 
by choosing the prEdit menu and selecting Check for Updates…



Activating prEdit
After you install prEdit onto a computer, it will need to be activated with a Serial Number 
before it can be used. Each serial number can be used to activate only one computer at a 
time. If you want to activate the software on another computer, you’ll need to deactivate it 
first. See Moving prEdit to another computer for details.
You’ll temporarily need internet access for the activation so that the software can connect to 
our server and confirm the serial number.

• When the software is first run it will display a Software License Agreement. Read the 
license agreement and click the I Agree button at the bottom of the page.

• Enter the Serial Number that was given to you and click the Activate button. The 
software will send the serial number to our server for confirmation.

• You’ll get a message in green saying that you’ve successfully activated your license. 
Click the Continue button.

If the software could not be activated with the Serial Number, you’ll get a message in red 
explaining the reason, such as:

• This is not a valid Serial Number - check to make sure you have entered the serial 
number correctly;

• This is not a Serial Number for prEdit - make sure you’re entering a serial number 
that can be used to activate prEdit;

• The Serial Number has already been activated - if you want to activate prEdit on this 
computer you'll need to deactivate the other installation before activating this one, or 
purchase another serial number.

Moving prEdit to another computer
To move prEdit from one computer to another, you'll deactivate it on the first computer, then 
activate the installation on the second computer.
To deactivate the software on one computer and activate it on a different computer, both 
computers will temporarily need internet access.

• On the first computer, choose Deactivate from the application menu.

• Confirm that you want to deactivate the software by clicking the Deactivate button.

• You’ll receive a message in green saying that you’ve successfully deactivated your 
license.

• On the second computer, run prEdit, and follow the instructions for Activating prEdit.


